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Upgrade Complexity 

 From prior version: Easy � 

Enhancements and revisions in Adagio FX 9.0B (2011.

NOTE: Adagio FX 9.0B is NOT compatible with any version of QuickBooks

New Features 

♦ Compatible with Simply Accounting 2012. Note: Budgets are retrieved as they were entered in Simply 
Revenue accounts. 

♦ You can now automatically retrieve a subset of the G/L into a separate data folder. This is useful in cases where you want individual 
Departments to have access to their financial data without having access to the G/L and without seeing other 
Windows scheduled task could be used to perform the retrieve after hours, so that the Department would have current data as of 
yesterday's closing. In order to implement this functionality, entri
added to the FX shortcut. See Auto Retrieve in the Help file for more detail

♦ Styles and Account Filters are available to display accounts in different colors and Filter accounts that meet specific crite

♦ Installs the AdagioPDF printer driver. All reports and printouts from Adagio can be printed to the AdagioPDF printer to create a PDF 
document in the data folder. 

♦ Adagio FX and Financial Reporter fully support the features in Adagio ePrint. When ePrint is installed you can print reports 
files in configurable folders determined by the Report Type (General, Transaction or Audit). Financial Statements and Stateme
Groups print to a separate, configurable folder. Fields can be embedded to establish the file and folder names (User, Session
System Date, Time). Click the ePrint button (red "EP" icon) on any report dialog to print the report to PDF. The Paperless Re
option forces all reports to be printed to PDF. Reports can be printed to PDF and attached to an email (MAPI) with a si
click. 

♦ Report Favorites allow saving Reports with specific options chosen. Click the Favorite button (a star icon) on any report dia
create a Favorite. Favorites for a report can be accessed from the report dialog in a drop
Adagio user or public for use by all users.
Print/Delete Favorites functions to the Reports menu. Multiple favorites can be defined for the sa

♦ Report Sets allow the grouping of Report Favorites and Statement Groups into a single print job that will run unattended. Rep
may be printed to printer or PDF files. Report Sets may be launched from a command file or a scheduled Windows 
FX.exe with the parameter /W followed by the Report Set (ex. /
used for Auto-retrieve in FX. A progress dialog lists the reports in the Report Set, the printing status of eac
filename and conflict strategy. A log is generated that records the printing status of each report in the set. Use Report Set
automate the printing of all your month end reports.
allows you to give a user access to particular 
even in print only mode, which would allow them to 

♦ Added User Preferences under the File menu. 
options previously found under File | Options, Reports | Report Options and the Company Profile (company background color). 
Includes new options 'On Start-up', 'Alphabetically sorted field list' and 'Exclude Ranges'
users and preferences can be printed. If no individual user preferences have been set up for a user, all preferences orig
the Adagio System Administrator, user SYS, will be used.
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Enhancements and revisions in Adagio FX 9.0B (2011.11.24) 

is NOT compatible with any version of QuickBooks®. 

Compatible with Simply Accounting 2012. Note: Budgets are retrieved as they were entered in Simply - the sign is flipped on 

automatically retrieve a subset of the G/L into a separate data folder. This is useful in cases where you want individual 
epartments to have access to their financial data without having access to the G/L and without seeing other 

heduled task could be used to perform the retrieve after hours, so that the Department would have current data as of 
yesterday's closing. In order to implement this functionality, entries must be made to the AFWININI file in the FX data folder and a /R 

ed to the FX shortcut. See Auto Retrieve in the Help file for more detailed instructions. 

Styles and Account Filters are available to display accounts in different colors and Filter accounts that meet specific crite

r. All reports and printouts from Adagio can be printed to the AdagioPDF printer to create a PDF 

Adagio FX and Financial Reporter fully support the features in Adagio ePrint. When ePrint is installed you can print reports 
files in configurable folders determined by the Report Type (General, Transaction or Audit). Financial Statements and Stateme
Groups print to a separate, configurable folder. Fields can be embedded to establish the file and folder names (User, Session
System Date, Time). Click the ePrint button (red "EP" icon) on any report dialog to print the report to PDF. The Paperless Re
option forces all reports to be printed to PDF. Reports can be printed to PDF and attached to an email (MAPI) with a si

Report Favorites allow saving Reports with specific options chosen. Click the Favorite button (a star icon) on any report dia
create a Favorite. Favorites for a report can be accessed from the report dialog in a drop-down field. Favorites can be private to the 
Adagio user or public for use by all users. Private Favorites are yellow, Public Favorites are blue. Added 
Print/Delete Favorites functions to the Reports menu. Multiple favorites can be defined for the same report.

Report Sets allow the grouping of Report Favorites and Statement Groups into a single print job that will run unattended. Rep
may be printed to printer or PDF files. Report Sets may be launched from a command file or a scheduled Windows 

by the Report Set (ex. /WMonthEnd). Note: in all other Adagio modules /R is used but /R is 
A progress dialog lists the reports in the Report Set, the printing status of eac

filename and conflict strategy. A log is generated that records the printing status of each report in the set. Use Report Set
automate the printing of all your month end reports. Report Sets can be private to the Adagio user or public for use by all users

give a user access to particular Report Sets containing statement groups, but no access to the 
even in print only mode, which would allow them to select/print any financial statement. 

Added User Preferences under the File menu. It allows you to set certain options by user that were previously global, including 
options previously found under File | Options, Reports | Report Options and the Company Profile (company background color). 

'Alphabetically sorted field list' and 'Exclude Ranges'. The preferences can optionally be set for all 
users and preferences can be printed. If no individual user preferences have been set up for a user, all preferences orig
the Adagio System Administrator, user SYS, will be used. 
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Product Compatibility Info link at www.softrak.com. 

Simply Accounting® 
to 2012 (see note 1) 

Windows XP, Vista, 7 
Office 2003, 2007 

the sign is flipped on 

automatically retrieve a subset of the G/L into a separate data folder. This is useful in cases where you want individual 
epartments to have access to their financial data without having access to the G/L and without seeing other Departments. A 

heduled task could be used to perform the retrieve after hours, so that the Department would have current data as of 
file in the FX data folder and a /R 

Styles and Account Filters are available to display accounts in different colors and Filter accounts that meet specific criteria. 

r. All reports and printouts from Adagio can be printed to the AdagioPDF printer to create a PDF 

Adagio FX and Financial Reporter fully support the features in Adagio ePrint. When ePrint is installed you can print reports to PDF 
files in configurable folders determined by the Report Type (General, Transaction or Audit). Financial Statements and Statement 
Groups print to a separate, configurable folder. Fields can be embedded to establish the file and folder names (User, Session Date, 
System Date, Time). Click the ePrint button (red "EP" icon) on any report dialog to print the report to PDF. The Paperless Reports 
option forces all reports to be printed to PDF. Reports can be printed to PDF and attached to an email (MAPI) with a single button 

Report Favorites allow saving Reports with specific options chosen. Click the Favorite button (a star icon) on any report dialog to 
vorites can be private to the 

Private Favorites are yellow, Public Favorites are blue. Added Favorite Reports and 
me report. 

Report Sets allow the grouping of Report Favorites and Statement Groups into a single print job that will run unattended. Report Sets 
may be printed to printer or PDF files. Report Sets may be launched from a command file or a scheduled Windows task by running 

Note: in all other Adagio modules /R is used but /R is 
A progress dialog lists the reports in the Report Set, the printing status of each, the destination folder, 

filename and conflict strategy. A log is generated that records the printing status of each report in the set. Use Report Sets to 
or public for use by all users. This 

statement groups, but no access to the Financial Reporter, 

It allows you to set certain options by user that were previously global, including 
options previously found under File | Options, Reports | Report Options and the Company Profile (company background color). 

The preferences can optionally be set for all 
users and preferences can be printed. If no individual user preferences have been set up for a user, all preferences originally set for 
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♦ The option 'Auto-advance smart finder' has been added (in the User Preferences function). It controls whether the focus is on the 
previously found grid or on the search criteria field when the smart finder is opened. Select the option if you want focus to be on the 
next row in the grid, allowing you to press F6, Enter and march through the found list. Turn it off if you usually want to search by a 
new criteria each time the smart finder is invoked. In either case the position is advanced in the grid each time the finder is opened.  

♦ The option 'Implied decimal' has been added (in the User Preferences function). Turn the option on if you want a decimal 
automatically entered before the last two digits. For example, typing 400 in an amount field and tabbing to the next field will result in 
the number being changed to 4.00; typing 400.00 and tabbing to the next field will leave the number as 400.00. With the option off, 
typing in 400 will result in the number being changed to 400.00 (the behavior in previous versions). Percent fields and exchange rate 
fields are not affected by this setting. The setting is by Adagio user, for all companies, and when set in any Adagio module, it is set 
for all Adagio module versions that support it. 

♦ Added 'Report Preview Options' in the File | Workstation Options function to allow you to set the default zoom factor and preview 
window state (full screen or partial screen) for previewing reports to screen. These settings are saved by workstation. Note: this 
applies to previewing reports only (but not previewing financial statements). 

♦ On the Open database dialog you can now use Alt-B to open the browse and Alt-F (for Favorites) to open the previously opened list. 
In previous versions you had to use the mouse to select the folder buttons. 

♦ Alt-X now selects the Excel Direct button on grids where it is available. In previous versions you had to use the mouse to select Excel 
Direct. 

♦ The vitalEsafe upload progress dialog has been improved and the progress bar now accurately shows the percentage. It is no longer 
necessary to install the vitalEsafe patch. 

♦ Added function to 'Print Financial Statements' to the Reports menu in FX to allow you to print financial statement groups without 
opening Financial Reporter. If 'Specify Fiscal Period' is set on the statement group you will be prompted to select the fiscal period 
and fiscal year. 

♦ Added ExcelDirect Financial Statements to the Reports menu to send statement groups directly to Excel without having to launch the 
Financial Reporter. 

Problems fixed 

♦ In the View Transactions/Budgets function in FX 9.0A, if you changed the year in the drop-down from the current to a prior year the 
View Detail and View GL Entry buttons became disabled until you closed and re-opened the function. 

♦ A problem occurred with data retrieved from Adagio G/L when Next Year was created before closing the Current Year. In this case, 
the QuerySheet function caused cells to display !Error and values returned were incorrect. 

♦ In Adagio FX 9.0A (2011.09.23) you received an error message when backups were uploaded to vitalEsafe, although the backup file 
was correctly uploaded. 

♦ When installing Adagio to a computer or server where no Adagio modules had previously been installed, if you installed an Adagio 
module that does not use the Crystal print engine first (such as Lanpak or GridView), when you installed FX you received the error 
"Adagio has been established on destination folder: [x:\SOFTRAK]. Yet the install cannot detect the corresponding Reports Tables..." 
and were unable to proceed. If the first module installed uses the Crystal print engine there was no problem. 

♦ The updated version of vitalEsafe no longer triggers a workstation install if it has already been installed by the workstation install for 
another Adagio module. This is also the case when installing Adagio for use with Remote Desktop Services (Terminal Services in 
Windows Server 2008 and previous versions). 

♦ After installing Adagio FX 9.0A (2011.09.23) at a site running certain other Adagio modules, where no other modules with a release 
date of October 2011 or later had been installed and run at least once on the station, the auto-workstation install ran every time you 
started the application in some cases, even if you had done a workstation install. There was not a problem at sites running FX only. 

Financial Reporter 

♦ You can now force a statement to “Fit to page” either by column or row. File | Page Setup allows you to fit the statement columns or 
rows to a specific number of pages. The printout will be scaled to fit the space available. 

♦ Editing a SmartSheet is now disabled if the sheet is expanded to prevent you making changes that will be discarded when the 
statement is refreshed. 

♦ A new function =ISEXPANDED() (returns TRUE() if the Smartsheet is expanded, otherwise returns FALSE()) has been added so 
that a formula can test the state of the financial statement.  

♦ 'Include Y/E Adj' and 'Ignore inactive accts' options have been added in statement groups. This information will be printed if 
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“Statement Group” is selected in File | Send to sheet. 

♦ The current row and column is now easier to determine with the column and row number highlighted.  

♦ You can now protect the Excel worksheet that is created when you ExcelDirect a financial statement. The Protect option is enabled 
in the Edit menu. 

♦ Remove Row and Remove Column on the Edit menu have been renamed Delete Row, Delete Column for consistency. 

♦ Speed keys have been added to most Menu choices. 

♦ The Verify SmartSheet command now ignores inactive accounts. 

♦ You can now enter hyperlinks such as web addresses into cells in a financial statement and these hyperlinks will be preserved when 
a statement is sent to Excel. 

Problems fixed 

♦ You are now prevented from changing the relative position of the Description column when creating a drag & drop Smartsheet as this 
caused problems in the construction of the cell formulas. 

♦ Saving a statement as a template now works correctly if the statement has not yet been given a name. The default directory for the 
Template is now the System area, not your data directory. 

♦ Selecting “Separate Dr/Cr columns” when creating a drag & drop financial statement now correctly ignores the Revenue sign on 
accounts. 

♦ It is now possible (or easier) to cancel a Print or Export of a Statement Group. 

♦ User Department Restrictions are now sorted by user code. 

♦ The maximum formula length has been increased. This will reduce the possibility of an error being returned from a formula 
containing the RNGMERGE function. 

♦ When using Departmental Restrictions, the value returned by the RNGMERGE function was understated. 

♦ When you right-clicked on a range of cells in a financial statement in FX 9.0A, the Copy and other options were missing when the 
SmartSheet was expanded. 

Enhancements and revisions in earlier versions of Adagio FX 

♦ Refer to the Readme help file for details of enhancements and revisions in earlier versions or Historical Enhancements under 
Products on Softrak's web site. 

Installing 

Read the section ‘Upgrading to this Version’ below before installing an upgrade. 

To install Adagio FX, you need the serial number and install code from the download email sent to you by Softrak Systems. 

If you are installing an upgrade, you need the serial number and install code from the upgrade download instruction email. A previous 
version of Adagio FX should already be installed on your computer before installing the upgrade. If a previous version is not already 
installed, you can still install the upgrade. After entering the upgrade serial number and install code, you will also have to enter the serial 
number and install code from a previous version. 

Read the sections below before installing an upgrade from an earlier version.  

To install Adagio FX (or an upgrade), run the program file you downloaded. Once the install program is running, you can click the View 
button for detailed instructions in the Readme help. If Adagio FX is installed on a network, you must also do a workstation install for 
each workstation running Adagio FX. Refer to the manual or to the “Installing on a Network” section in the Readme for instructions. 

Note 1: When used with Simply Accounting, Adagio FX requires that Simply Accounting programs be installed on the machine where 
FX is run. 

Adagio FX no longer supports and is not compatible with any version of QuickBooks®. Do not install this upgrade if you retrieve data 
from QuickBooks. 

Upgrading to 9.0B from 9.0A  Upgrade Complexity:  Easy � 

Adagio FX 9.0B requires Adagio Lanpak to be version 9.0D or higher. Do not install this upgrade before you have installed 
Lanpak 9.0D if you require multiple users in Adagio FX. If you have any prior version Lanpaks installed but no 9.0D Lanpaks, the 
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Adagio FX install will warn you. 

When new features are added to the Financial Reporter, new buttons may also be added to the toolbar. In order to view the new 
buttons, you may need to reset your toolbar after upgrading. To do this, go to View | Customize, Toolbars tab, select each toolbar in the 
list and click the Reset button each time. 

Financial statements created by or converted by Adagio FX 9.0B cannot be opened by earlier versions of Adagio FX. After opening the 
9.0B Financial Reporter the database is no longer compatible with earlier versions of FX. 

Before installing the new version you should perform a Data Integrity Check of your database(s) at your current version to ensure there 
are no integrity errors. 

There are no other special considerations when upgrading to Adagio Invoices 9.0B from version 9.0A and no database conversion is 
required. The information below can be skipped. 

Upgrading to 9.0B from versions earlier than 9.0A  Upgrade Complexity:  Intermediate � 

Adagio FX 9.0A was a major upgrade, containing many changes and new features. If you are upgrading to 9.0B from a version 
earlier than 9.0A it is very important to review the information below regarding 9.0A before installing the upgrade.  

Upgrading to 9.0A – installing the upgrade 

Adagio FX 9.0A will be installed to the \softrak\fx folder. Previous versions were installed in \softrak\afwin. 

When installing an upgrade to 9.0A you can delete (uninstall) the previous version (8.1C or older) or leave it installed. If the install 
detects a prior version, it will ask you if you want to remove it. 

In most cases users will not need the previous version. However, if you have databases for QuickBooks or databases for multiple 
companies and do not want to convert them all at the same time you may want to leave the previous version installed. 

Note: If you run an old version of FX on the same machine as 9.0A, there can be some unexpected affects on screen sizes and 
positions, and on grid, finder and smart finder settings, as these settings will be shared by both versions. If you are running on a 
network, help will not be available for your earlier version – the help window will show “Action canceled”. 

Uninstalling the previous version removes everything from the program folder \softrak\afwin that got installed but leaves everything else 
that you may have created manually, including the CustomRP and ModRP folders. 

The upgrade install cannot change any custom icons you may have created to launch FX and they will continue to run your previous 
version if it was not uninstalled or will display a “missing shortcut” error if it was uninstalled. You must change these icons manually to 
run FX from \softrak\fx\fx.exe. 

Upgrading to 9.0A – converting your database 

Earlier versions of Adagio FX must be converted for use with 9.0A.  

To start the conversion, open your current database that used your previous version of Adagio FX. A warning is displayed indicating the 
database will be converted and a backup must be made. 

Upgrading to 9.0A – after conversion 

The program folder moves to \softrak\fx for version 9.0A. Previous versions of Adagio FX are installed to \softrak\afwin. Likewise, the 
program filename changes to fx.exe whereas previous program versions were named afwin.exe.  

The Windows Start list entry for version 9.0A will default to ‘FX 9’. The Windows Start list entry for earlier versions defaulted to ‘FX’, and 
this entry will be left on your start list unless you uninstalled the earlier version. Use the new entry for FX 9. When installing an upgrade 
you should change any icons on your desktop or in desktop folders to run FX using the new program name and folder (see 
above paragraph). If you open FX 9.0A data with an older version of FX, you will see a message such as “Data version [9000] may not 
be compatible.". This indicates you need to change your icon. 

Settings made in the Column Editor to grids, finders and smart finders for previous versions of FX may need to be redone or adjusted 
for FX 9.0A. 

The Previously Opened database list is saved by Adagio User rather than for all users. The first time an existing user or a new user logs 
into Adagio FX they will be asked “Would you like your historical company access list set up?” Answer yes to have FX add all entries 
from the Previously Opened list from your prior version. It is no longer possible for all users to share the same Previously Opened list. 

Adagio FX 9.0A uses a new Crystal Reports for Adagio table - AFW90. Custom reports should be updated to use the new table. You 
must also recreate any of the standard reports shipped with Adagio FX that you have modified (located in the ModRP folder).  
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Upgrading to 9.0A – converting custom reports 

If you have modified any of the standard reports installed by Adagio FX you will have to redo those modifications for FX 9.0A. Modified 
reports are files with an .rpt extension that you copied from \softrak\afwin\StandardRP to \softrak\afwin\ModRP and modified using 
Crystal Reports for Adagio. Your modified reports from your prior version will be copied to the folder \softrak\fx\ModRP.priorversion. Re-
modified reports must be placed in \softrak\fx\ModRP. 

Installing the FX 9.0A upgrade does not delete your original modified reports in \softrak\afwin\ModRP, even if you uninstall your prior 
version. When you are certain these reports are no longer needed, you can delete the \softrak\fxwin\ModRP folder. 

Custom reports created in Crystal Reports for Adagio for earlier versions of FX should be modified or recreated for use with FX 9.0A 
databases in most cases. Your custom reports from your prior version will be copied to the folder \softrak\fx\CustomRP.priorversion. 
Recreated custom reports must be placed in \softrak\fx\CustomRP. Installing the FX 9.0A upgrade does not delete your original custom 
reports in \softrak\afwin\CustomRP, even if you uninstall your prior version. When you are certain these reports are no longer needed, 
you can delete the \softrak\afwin\CustomRP folder. 

The Crystal table for 9.0A is ‘AFW90’ It replaces 'AFW80' from earlier versions. 

-- end -- 


